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 Federal Data Quality Information 
 
In compliance with Public Law 106-554 regarding federal data quality, the following information 
is provided in relation to information obtained from this site 
(ridb.recreation.gov). 

 
Users of this federally provided data understand and accept the following:  
1.  This information is provided as “general reference” information.  
2.  Information is provided for the sole purpose of describing outdoor recreation-related opportunities 
on federally managed lands and may not be inclusive of all federal opportunities.  
3.  This information is provided by, and periodically updated by, participating federal agencies 

and it is the user’s responsibility to check for and obtain revised information.  
4.  This site does not control nor guarantee the accuracy, relevance, timeliness or completeness of 

information contained on a website URL provided in the dataset downloaded.  
5.  This site does not endorse the organizations sponsoring linked websites, and we do not endorse 

the views they express or the products/services they offer.  
6.  Information provided in the XML datasets is public domain and may be reused for the 

intended purpose.  
7.  This site does not authorize the use of copyrighted materials contained in linked websites. 

Users must request such authorization from the sponsor of the linked website.  
8.  This site is not responsible for transmissions that users receive from linked websites provided 

within the datasets downloaded.  
9.  This site does not guarantee that outside websites comply with Section 508 (Accessibility 

Requirements) of the Rehabilitation Act.

http://ridb.recreation.gov/


RIDB Web Services Manual 
 
 

 

4 

 

 Introduction 
 
The Recreation Information Database (RIDB) provides data resource to citizens, offering a single point of 
access to information about recreational opportunities nationwide. The web site represents an authoritative 
source of information and services for millions of visitors to federal lands, historic sites, museums, and other 
attractions/resources. This initiative integrates multiple Federal channels and sources for find out about 
recreation opportunities into a one-stop, searchable database of recreational areas nationwide. This document 
describes the process to extract data from the RIDB using the menu driven process. This is also a technical 
document which describes how to message and interface with the RIDB Web Services. This document 
assumes that the reader is familiar with web services and understands terminology such as HTTP, GET, 
POST, WSDL, UDDI, SOAP, etc.  
The RIDB Web Services are "classic" web services because they are: 

 
•  Self-describing via their own WSDL documents, and  
•  Communicate with clients via SOAP over HTTP/HTTPS. 

 Intended Audience 
 
This document is intended for the general public. It provides instructions on how to extract data from the 
RIDB.  
The data is provided at no cost in order to encourage wide distribution and regular updates to different 
publications, databases, and websites, so customers can receive correct information from many different 
systems.  
You are invited to use the trip planning data about Federal recreation sites in your publication, website, or 
computer system. You can download and use the trip planning data at no cost, and with no copyright 
issues.  
There is no need to contact us before incorporating the data into your system. In exchange, we encourage you 
to provide a link to Recreation.gov and acknowledge credit, such as Data Source: ridb.recreation.gov 

 Retrieving RIDB Data via Menu 
Data from the Recreation Information Database (RIDB) can be retrieved using the menu driven process 
accessed at http://ridb.recreation.gov/.  
It is not necessary to log in to the RIDB to retrieve data. Select “Data Sharing” from the RIDB home page. 
Using the drop down menus, make appropriate selections to extract data records from the RIDB. There are 
options to retrieve all data contained in the RIDB, data for an entire agency, or data for a specific 
organization within an agency. The resulting links will allow the selection of: 

 
Recreation Area and Facility Information: 

1. All rec area and facility data elements in the RIDB based on the retrieval criteria selected 
2. Recreation Area data elements based on the retrieval criteria selected 

http://ridb.recreation.gov/
http://ridb.recreation.gov/
https://ridb.recreation.gov/?action=datasharing
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3. Facility data elements based on the retrieval criteria selected 
 
Site Level Information: 
1. All site level data elements in the RIDB based on the retrieval criteria selected 
2. Campsite site data elements based on the retrieval criteria selected 
3. Tour site data elements based on the retrieval criteria selected 
4. Permit site data elements based on the retrieval criteria selected 

 
* Output will be provided in XML format. 

 Retrieving the WSDLs 
 
Web services publish their own API in an XML format called Web Service Definition Language (WSDL). 
The WSDLs must be retrieved directly from each of the web services, as shown below. 
 
• Recreation Area and Facility Data: 

o http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?wsdl    
• Site level data:  

o http://ridb.recreation.gov/webservices/RIDBServiceSite.cfc?wsdl  
• Advanced Search 

o http://ridb.recreation.gov/webservices/RIDBServiceAdv.cfc?wsdl   
 
Some RIDB web service methods fetch data via an HTTP GET request. Some of those methods accept 
parameters, which are passed in the URL as part of a GET request.  
As shown in the WSDLs, the method calls and their respective URLs for the methods are listed below. For 
cases in which the method accepts parameters, sample parameters are included.  
 
*  Note that the WSDLs, and not this document, are the final word on the precise format of these method 
signatures.   
** Note that some of the example links below provide a sample organization ID (e.g. OrgID=128). Remember 
to use the dropdowns under “data sharing” to navigate to the organization you wish to receive data for and use 
the links provided to get the correct Org ID. Use -1 as the OrgID to retrieve data for all organizations.    

 Recreation Area and Facility (RIDBService) Methods 
 
The following method returns RIDB data in the REC.xsd, or Recreation.gov schema format. Note: 
Recreation.Gov Facilities map to both RIDB RecAreas and RIDB Facilities. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getRecGovFacilities 
 
The following method returns all RIDB Elements that are currently supported. 
This method uses the RecML schema format. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllElements 
 

http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?wsdl
http://ridb.recreation.gov/webservices/RIDBServiceSite.cfc?wsdl
http://ridb.recreation.gov/webservices/RIDBServiceAdv.cfc?wsdl
https://ridb.recreation.gov/?action=datasharing
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getRecGovFacilities
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllElements
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The following method returns RIDB elements that relate to the input Organization and all sub-Organizations for 
a given OrgID (and its sub-orgs). All elements related to those Organizations are returned. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllRecElementsForOrgID&OrgID=128  
 
The following method returns facility-related RIDB elements, by Organization and all sub-Organizations for a 
given OrgID (and its sub-orgs). All facilities and elements related to those facilities are returned. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllFacilityElementsForOrgID&OrgID=
128 
 
The following method returns RecArea-related RIDB elements, by Organization and all sub-Organizations for a 
given OrgID (and its sub-orgs). All RecAreas and elements related to those RecAreas are returned. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllRecAreaElementsForOrgID&OrgID
=128 
 
Note: Unless otherwise indicated, all of the following methods use the RecML schema format. 
 
The following method returns all RIDB Facilities. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllFacilities 
 
The following method returns all RIDB RecAreas. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllRecAreas 
 
The following method returns all RIDB Facilities that relate to the single Organization specified by the input 
OrgID. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllFacilitiesForOrgID&OrgID=128 
 
The following method returns all RIDB RecAreas that relate to the single Organization specified by the input 
OrgID. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllRecAreasForOrgID&OrgID=128 
 
The following method returns all RIDB Organizations. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllOrganizations 
 
The following method returns all RIDB Activities. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllActivities 
 
The following method returns all RIDB Facility Addresses. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllFacilityAddresses 
 
The following method returns all RIDB RecArea Addresses. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllRecAreaAddresses 
 
The following method returns all RIDB Facility Activities. 
 

http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllRecElementsForOrgID&OrgID=128
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllFacilityElementsForOrgID&OrgID=128
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllFacilityElementsForOrgID&OrgID=128
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllRecAreaElementsForOrgID&OrgID=128
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllRecAreaElementsForOrgID&OrgID=128
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllFacilities
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllRecAreas
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllFacilitiesForOrgID&OrgID=128
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllRecAreasForOrgID&OrgID=128
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllOrganizations
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllActivities
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllFacilityAddresses
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllRecAreaAddresses
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http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllFacilityActivities 
 
The following method returns all RIDB RecArea Activities. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllRecAreaActivities  
 
The following method returns all RIDB RecArea Facilities. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllRecAreaFacilities 
 
The following method returns all RIDB Org Facilities. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllOrgFacilities 
 
The following method returns all RIDB Org RecAreas. 
 
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllOrgRecAreas 
 

 RIDBService XML Schema Definition (XSD) 
 
The RIDBService XSD can be found online at http://ridb.recreation.gov/webservices/RIDBServiceNG.xsd  

 

 Site Level Data (RIDBServiceSite) Methods 
 
The following method returns all RIDB Site Elements: 
 
http://ridb.recreation.gov/webservices/RIDBServiceSite.cfc?method=getAllSiteElementsForOrgID&OrgID=1
28 
 
The following method returns all RIDB Campsite Elements: 
 
http://ridb.recreation.gov/webservices/RIDBServiceSite.cfc?method=getAllCampsitesForOrgID&OrgID=128 
 
The following method returns all RIDB Permit Site Elements: 
 
http://ridb.recreation.gov/webservices/RIDBServiceSite.cfc?method=getAllPermitEntrancesForOrgID&OrgI
D=128 
 
 
The following method returns all RIDB Tour Site Elements: 
 
http://ridb.recreation.gov/webservices/RIDBServiceSite.cfc?method=getAllToursForOrgID&OrgID=128 

http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllFacilityActivities
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllRecAreaActivities
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllRecAreaFacilities
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllOrgFacilities
http://ridb.recreation.gov/webservices/RIDBServiceNG.cfc?method=getAllOrgRecAreas
http://ridb.recreation.gov/webservices/RIDBServiceNG.xsd
http://ridb.recreation.gov/webservices/RIDBServiceSite.cfc?method=getAllSiteElementsForOrgID&OrgID=128
http://ridb.recreation.gov/webservices/RIDBServiceSite.cfc?method=getAllSiteElementsForOrgID&OrgID=128
http://ridb.recreation.gov/webservices/RIDBServiceSite.cfc?method=getAllCampsitesForOrgID&OrgID=128
http://ridb.recreation.gov/webservices/RIDBServiceSite.cfc?method=getAllPermitEntrancesForOrgID&OrgID=128
http://ridb.recreation.gov/webservices/RIDBServiceSite.cfc?method=getAllPermitEntrancesForOrgID&OrgID=128
http://ridb.recreation.gov/webservices/RIDBServiceSite.cfc?method=getAllToursForOrgID&OrgID=128
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 Sample RIDBServiceSite XML Schema Definition (XSD) 
 
The RIDBServiceSite XSD can be found online at http://ridb.recreation.gov/webservices/RIDBServiceSite.xsd  

 Advanced Search (RIDBServiceAdv) Methods 
 

The following method returns RIDB facilities, recreation areas, and site level data based on search criteria 
specified: 

http://ridb.recreation.gov/webservices/RIDBServiceAdv.cfc?method=ExportbySearchCriteria&format=XML&s
earchText=&checkrecarea=true&checkFacility=true&listActivity=4&listState=AL&listOrg=132&maxResults=
10&startIndex=0&sortColumn=0&sortdir=asc 

Parameters available: 
 
Parameter Data Type Description 
searchText String Text to search for. Limit: 

100 characters 
checkRecArea Boolean Include Rec Areas 

(true/false) 
checkFacility Boolean Include Facilities (true 

false) 
listActivity String Comma delimited list of 

activity IDs 
listState String Comma delimited list of 

state abbreviations 
listOrg String Comma delimited list of org 

IDs 
maxResults Numeric Maximum results per batch. 

Limit: 50 
startIndex Numeric Start row of current batch (0 

based) 
sortColumn Numeric Column results sorted on 

(column ID 0/1/2) 
Sortdir Numeric Sort direction (asc/desc).   
format String Export format. Possible 

values: “XML” or “JSON” 
 

The following method returns a single recreation area or facility based on the parameters provided: 

http://ridb.recreation.gov/webservices/RIDBServiceAdv.cfc?method=ExportbyEntityIDandEntityType&format
=XML&EntityID=1977&EntityType=RecArea  

http://ridb.recreation.gov/webservices/RIDBServiceSite.xsd
http://ridb.recreation.gov/webservices/RIDBServiceAdv.cfc?method=ExportbySearchCriteria&format=XML&searchText=&checkrecarea=true&checkFacility=true&listActivity=4&listState=AL&listOrg=132&maxResults=10&startIndex=0&sortColumn=0&sortdir=asc
http://ridb.recreation.gov/webservices/RIDBServiceAdv.cfc?method=ExportbySearchCriteria&format=XML&searchText=&checkrecarea=true&checkFacility=true&listActivity=4&listState=AL&listOrg=132&maxResults=10&startIndex=0&sortColumn=0&sortdir=asc
http://ridb.recreation.gov/webservices/RIDBServiceAdv.cfc?method=ExportbySearchCriteria&format=XML&searchText=&checkrecarea=true&checkFacility=true&listActivity=4&listState=AL&listOrg=132&maxResults=10&startIndex=0&sortColumn=0&sortdir=asc
http://ridb.recreation.gov/webservices/RIDBServiceAdv.cfc?method=ExportbyEntityIDandEntityType&format=XML&EntityID=1977&EntityType=RecArea
http://ridb.recreation.gov/webservices/RIDBServiceAdv.cfc?method=ExportbyEntityIDandEntityType&format=XML&EntityID=1977&EntityType=RecArea


RIDB Web Services Manual 
 
 

 

9 

 

Parameters available: 
 
Parameter Data Type Possible Values 
entityID Numeric Facility or Recreation Area 

ID 
entityType String Possible values: “Facility” 

or “RecArea” 
format String Export format. Possible 

values: “XML” or “JSON” 
 

 RIDB Data Dictionary 
 

12.1. Organization 
Organization the recreation area or facility is associated to (e.g. U.S. Forest Service, National Park Service) 

Field Name Format Length Optional Description 

OrgID INT  N Organization ID 

OrgName STRING 60 N Full name of organization 

OrgAbbrevName STRING 20 Y Abbreviated name of the organization 

OrgURLAddress STRING 256 N Internet address (URL) for web site of 
the organization responsible for 
submitting and maintaining the data to 
be exchanged 

OrgURLText STRING 256 Y Optional Readable text that provides 
the URL address link 

OrgImageURL STRING 256 Y Internet address (URL) that hosts the 
sample image or photo of the 
organization 

OrgType STRING 40 Y Organization type 

OrgJurisdictionType STRING 20 Y Organization jurisdiction type 

Enabled BIT  N Is the Organization Active 
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12.2. OrgRecAreaRole 
Joins organizations to recreation areas (the “role” portion of this name has been deprecated) 

Field Name Format Length Optional Description 

OrgID INT  N Foreign Key: Organization OrgID 

RecAreaID INT  N Foreign Key: RecArea RecAreaID 

OrgRecAreaReason STRING 60 Y Brief Reason (Not currently used) 

 

12.3. OrgFacilityRole 
Joins organizations to facilities (the “role” portion of this name has been deprecated) 

Field Name Format Length Optional Description 

OrgID INT  N Foreign Key: Organization OrgID 

FacilityID INT  N Foreign Key: Facility FacilityID 

OrgFacilityRoleReason STRING 60 Y Brief Reason (Not currently used) 

 

12.4. RecArea 
Recreation area records (e.g. Yosemite National Park, Aldo Leopold Wilderness) 

Field Name Format Length Optional Description 

RecAreaID INT  N RecArea ID 

OrgRecAreaID INT  Y Foreign Key: Organization 
OrgID 

RecAreaName STRING 256 N Full Name of the recreational 
area 

RecAreaDescription STRING MAX* N Text that describes the 
recreational area 

RecAreaDirections STRING MAX* Y Directions to the recreational 
area 
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Field Name Format Length Optional Description 

RecAreaFeeDescription STRING MAX* Y Text describing monetary 
charges associated with entrance 
to or usage of a recreational area 

RecAreaMapURL STRING 256 Y Internet address (URL) that 
hosts the recreational area map 

RecAreaReservationURL STRING 256 Y Internet address (URL) for the 
web site hosting the reservation 
system 

RecAreaPhone STRING 256 Y Phone number for recreational 
area 

RecAreaEmail STRING 256 N Email address of the recreational 
area 

RecAreaLatitude DECIMAL  Y Latitude in decimal degrees -
90.0 to 90.0 

RecAreaLongitude DECIMAL  Y Longitude in decimal degrees -
180.0 to 180.0 

Enabled BIT  N Is the recreational area Active 

Keywords STRING 4000 Y List of keywords for the 
recreational area 

StayLimit STRING 500 Y Details on the stay limits for the 
recreational area 

 

12.5. Facility 
Facility records (e.g. Yellowstone Group Campground, Barnum Whitewater Area) 

Field Name Format Length Optional Description 

FacilityID INT  N Facility ID 

OrgFacilityID INT  N Foreign Key: Organization OrgID 

FacilityName STRING 256 N Full name of the facility 
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Field Name Format Length Optional Description 

FacilityTypeDescription STRING 1024 Y Description of the type of facility 

FacilityPhone STRING 256 Y Phone number of the facility 

FacilityDescription STRING MAX* N Text describing the main features of the 
facility 

FacilityDirections STRING MAX* Y Text that provides general directions and/or 
the general location of the facility 

FacilityEmail STRING 60 Y Email address of the facility 

FacilityMapURL STRING 256 Y Internet address (URL) that hosts the facility 
map 

FacilityReservationURL STRING 256 Y Internet address (URL) for the web site 
hosting the reservation system 

FacilityLatitude DECIMAL  Y Latitude in decimal degrees -90.0 to 90.0 

FacilityLongitude DECIMAL  Y Longitude in decimal degrees -180.0 to 180.0 

FacilityAdaAccess STRING 1024 Y Information about the Americans with 
Disabilities Act accessibility for the facility 

FacilityUseFeeDescription STRING MAX* Y Text describing monetary charges associated 
with entrance to or usage of the facility 

Enabled BIT  N Is the facility active 

LastUpdatedBy INT  N ID of the Data Steward that last updated the 
Facility 

LegacyFacilityID STRING 20 Y Legacy facility ID 

Keywords STRING 4000 Y List of keywords for the facility 

StayLimit STRING 500 Y Details on the stay limits for the facility 
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12.6. RecAreaActivity 
Joins recreation areas to associated activities 

Field Name Format Length Optional Description 

RecAreaID INT  N Foreign Key: RecArea RecAreaID 

ActivityID INT  N Foreign Key: RecreationalActivity 
ActivityID 

RecAreaActivityDescription STRING 1024 Y Description of the recreational area 
activity 

RecAreaActivityFeeDescription STRING 1024 Y Text describing monetary charges 
associated with the activity 

 

12.7. FacilityActivity 
Joins facilities to associated activities 

Field Name Format Length Optional Description 

FacilityID INT  N Foreign Key: Facility FacilityID 

ActivityID INT  N Foreign Key: RecreationalActivity 
ActivityID 

FacilityActivityDescription STRING 1024 Y Description of the facility activity 

FacilityActivityFeeDescription STRING 1024 Y Text describing monetary charges 
associated with the activity 

 

12.8. RecreationalActivity 
List of all activities  

Field Name Format Length Optional Description 

ActivityID INT  N Activity ID 

RecActivityName STRING 60 N Name of the activity 
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Field Name Format Length Optional Description 

RecActivityLevel INT  N Amount of physical exertion to be expected for a given 
activity such as hiking, swimming, etc 

 

12.9. RecAreaAddress 
Recreation area addresses 

Field Name Format Length Optional Description 

AddressID INT  N Address ID 

StreetAddress1 STRING 256 Y Address Line 1 of the recreational area 

StreetAddress2 STRING 256 Y Address Line 2 of the recreational area 

StreetAddress3 STRING 256 Y Address Line 3 of the recreational area 

City STRING 60 Y City where the recreational area is 
located 

AddressStateCode STRING 20 N State code for the recreational area 

PostalCode STRING 20 Y Postal code for the recreational area 

AddressCountryCode STRING 5 Y Abbreviated country code for the 
recreational area address 

RecAreaID INT  N Foreign Key: RecArea RecAreaID 

RecAreaAddressType STRING 20 Y Address Type for the recreational area 
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12.10. FacilityAddress 
Facility addresses 

Field Name Format Length Optional Description 

AddressID INT  N Address ID 

StreetAddress1 STRING 256 Y Address Line 1 of the facility 

StreetAddress2 STRING 256 Y Address Line 2 of the facility 

StreetAddress3 STRING 256 Y Address Line 3 of the facility 

City STRING 60 Y City where the facility is located 

AddressStateCode STRING 20 N State code for the facility 

PostalCode STRING 20 Y Postal code for the facility 

AddressCountryCode STRING 5 Y Abbreviated country code for the facility 
address 

FacilityID INT  N Foreign Key: Facility FacilityID 

FacilityAddressType STRING 20 Y Address type for the facility 

 

12.11. RecAreaEvent 
Joins recreation areas to associated events 

Field Name Format Length Optional Description 

RecAreaID INT  N Foreign Key: RecArea RecAreaID 

EventID INT  N Foreign Key: Event EventID 

 

12.12. FacilityEvent 
Joins facilities to associated events 

Field Name Format Length Optional Description 

FacilityID INT  N Foreign Key: Facility FacilityID 

EventID INT  N Foreign Key: Event EventID 
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12.13. Event 
List of all events (e.g. Boat race, Archery Tournament) 

Field Name Format Length Optional Description 

EventID INT  N Event ID 

EventDataStewardID INT  Y Data Steward ID for 
the event 

EventName STRING 60 N Full Name of the 
event 

EventStartDate DATETIME  N Calendar date on 
which event is 
scheduled to begin 

EventDescription STRING 1024 N Text that provides a 
synopsis of an event 

EventAgeGroup STRING 20 Y Age group for the 
event if available 

EventURLAddress STRING 256 Y Internet address 
(URL) to a web site 
providing details 
about the event 

EventURLText STRING 256 Y Optional text for the 
URL of the event 

EventEmail STRING 60 Y Email contact for 
event 

EventRegistrationRequired BIT  N Code requesting a Yes 
or No response to 
determine whether 
registration is required 
for an event 

EventADAAccess STRING 1024 Y Information about the 
Americans with 
Disabilities Act 
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Field Name Format Length Optional Description 

accessibility for the 
event 

EventFeeDescription STRING 1024 Y Text for the 
description of fees 
associated with this 
event 

EventComments STRING 1024 Y Text for the general 
occasion or activity to 
be offered 

EventFrequencyRateDescription STRING 1024 Y Text that describes 
how often the event 
recurs 

EventScopeDescription STRING 1024 Y Text that describes the 
extent, capacity, and 
scale of an event. 

EventTypeDescription STRING 1024 Y Text that describes the 
types of events 

SponsorName STRING 60 Y Full Name of the 
sponsor for the event 

SponsorEmail STRING 60 Y Sponsor email address 
for the event 

SponsorURLAddress STRING 256 Y Internet address 
(URL) to a web site 
for the sponsor 

EventEndDate DATETIME  N Calendar date on 
which event is 
scheduled to end 

SponsorURLText STRING 256 Y Optional Readable 
text that provides the 
URL Sponsor link 
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Field Name Format Length Optional Description 

SponsorPhone STRING 20 Y Phone Number for the 
sponsor of the Event 

SponsorClassType STRING 20 Y Class and type of 
sponsor 

 

12.14. RecAreaFacility 
Joins recreation areas to associated facilities 

Field Name Format Length Optional Description 

RecAreaID INT  N Foreign Key: RecArea RecAreaID 

FacilityID INT  N Foreign Key: Facility FacilityID 

 

12.15. EntityLink 
Hyperlink to an external site (e.g. Agency site, Facebook, Twitter) 

Field Name Format Length Optional Description 

EntityType STRING 50 N RecArea or Facility 

EntityID INT  N Foreign Key: (RecArea RecAreaID) OR 
(Facility FacilityID) 

LinkType STRING 500 N Type of link, e.g. Facebook, Twitter, 
Official site 

URL STRING 2000 N Internet address (URL) to a web site 

Title STRING 500 N Full text title 

Description STRING MAX* Y Text description of the entity link 
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12.16. EntityMedia 
Media links (e.g. images, video) 

Field Name Format Length Optional Description 

EntityType STRING 50 N RecArea, Facility, Tour, Entrance, or Site  

EntityID INT  N Foreign Key: (RecArea RecAreaID) OR 
(Facility FacilityID) OR (Tour TourID) OR 
(PermitEntrance PermitEntranceID) OR 
(Campsite CampsiteID) 

MediaType STRING 500 N Type of Media, e.g. Image, Video, etc. 

URL STRING 2000 N Internet address (URL) to the entity media 

Title STRING 500 N Full title of the entity media 

Subtitle STRING 1000 Y Optional subtitle of the entity media 

Description STRING MAX* Y Optional description of the entity media 

Credits STRING 1000 Y Optional credit for entity media 

Height INT  N Height in pixels for media image 

Width INT  N Width in pixels for the media image 

EmbedCode STRING MAX* Y Optional embedded code for media entity 

 

12.17. Campsite 
Campsite records 

Field Name Format Length Optional Description 

CampsiteID INT  N Campsite ID 

FacilityID INT  N Facility ID the campsite belongs to 

CampsiteName STRING 255 N Campsite Name 

CampsiteType STRING 255 Y Campsite Type 

Loop STRING 255 Y Name of loop the campsite resides on 
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Field Name Format Length Optional Description 

Type of Use STRING 255 Y Type of use  

CampsiteAccesible STRING 10 Y Is the campsite accessible by vehicle 

CreatedDate DATETIME  N Record creation date 

LastUpdateDate DATETIME  N Record last update date 

LastUpdatedBy INT  N Record last updated by 

12.18. PermittedEquipment 
Permitted Equipment associated to campsites (e.g. tent, trailer) 

Field Name Format Length Optional Description 

EquipmentName STRING 255 N Equipment Name 

MaxLength INT  Y Maximum length of equipment 

 

12.19. Tour 
Tour records 

Field Name Format Length Optional Description 

TourID INT  N Tour ID 

FacilityID INT  N Facility ID the tour belongs to 

TourName STRING 255 N Tour name 

TourType STRING 255 Y Tour Type 

TourDescription STRING 255 Y Tour description 

TourDuration INT  Y Tour duration 

TourAccessible STRING 10 Y Is the tour accessible by vehicle 

CreatedDate DATETIME  N Record creation date 

LastUpdatedDate DATETIME  N Record last update date 
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Field Name Format Length Optional Description 

LastUpdatedBy INT  N Record last updated by 

 

12.20. PermitEntrance 
Permit entrance records 

Field Name Format Length Optional Description 

PermitEntranceID INT  N Permit Entrance ID 

FacilityID INT  N Facility ID the Permit belongs to 

PermitEntranceName STRING 512 N Permit Entrance Name 

PermitEntranceType STRING 255 Y Permit Entrance Type 

PermitEntranceDescription STRING 255 Y Permit Entrance Description 

PermitEntranceAccesible STRING 10 Y Is the permit accessible by vehicle 

Latitude DECIMAL   Latitude of the permit location 

Longitude DECIMAL   Longitude of the permit location 

District STRING 60 Y District the permit resides in 

Town STRING 60 Y Town the permit resides in 

Zone STRING 255 Y Zone the permit resides in 

CreatedDate DATETIME  N Record creation date 

LastUpdatedDate DATETIME  N Record last update date 

LastUpdatedBy INT  N Record last updated by 

 

12.21. Attribute 
Attributes associated to campsites, tours, and permit entrances (e.g. checkout time, shade, water hookup) 

Field Name Format Length Optional Description 

AttributeName STRING 60 Y Attribute name 
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Field Name Format Length Optional Description 

AttributeValue STRING 255 Y Attribute value 

 

* A character limit will be enforced on these fields in the future 

 Entity Relationship Diagram 
This diagram illustrates the entity relationships for data provided in the RIDB web services. The diagram does 
not list all table attributes. Associative table relationships are represented on the diagram with a labeled line 
connector. 
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 How to Insert RIDB XML Data into Excel 
XML can be imported into Excel in a variety of ways. This process is but one of them. Thanks to 
office.microsoft.com which was used as the basis for this documentation. 

1. Open Microsoft Excel 
2. Create an XML Map using the RIDB Service XML Schema Definition (XSD) 

a. If you don't see the Developer tab, do the following to display it: 
i. In Excel 2013 and Excel 2010: 

1. Click File > Options. 
2. In the pane on the left, click the Customize Ribbon category. 
3. Under Main Tabs, check the Developer box, then click OK. 

ii. In Excel 2007: 
1. Click the Microsoft Office Button, and then click Excel Options. 
2. In the pane on the left, click the Popular category. 
3. Under Top options for working with Excel, check the Show Developer tab in 

the Ribbon box, then click OK. 
b. Click Source in the XML group on the Developer tab. 

               

c. The XML Source task pane appears. 
d. Click XML Maps, and then click Add. 
e. In the Look in list, click the drive, folder, or Internet location that contains the file you want to 

open. For this example, and for RIDB data, we will paste the hyperlink to the RIDB Service XSD. 
Then click open. This will create an XML map based on the RIDB XML schema. 

f. Click OK. 
g. The XML map is displayed in the XML Source task pane. 

 

http://office.microsoft.com/en-us/excel-help/map-and-unmap-xml-elements-HP010206397.aspx
http://ridb.recreation.gov/webservices/RIDBServiceNG.xsd
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3. Map the XML elements to the sheets and columns 
a. Map each XML node (e.g. ns1:Organization, ns1:RecArea) in the XML Source pane on the right 

to the sheets and columns desired by right clicking the XML node  Map Element. The cell range 
will automatically be included as selected with the desired node. 

  

b. Accept the default and click “Ok” 
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c. For ease of use, you may want to create a sheet for each node. For example, create a sheet named 
”Organization” for the “Organization” XML node and map the node to it, create another sheet for 
the “OrgRecAreaRole” node and map it, etc. Repeat for all XML data nodes desired. 

4. Import the XML data 
a. Download the desired XML data file from the RIDB. For this example, we’ll be using the RIDB 

“View All Rec Areas” service method for the U.S Forest Service. 

 

b. Right click one of the mapped columns and select XML  Import. Browse to the XML file you 
downloaded in step a.) above. Select OK and the data will import into the Excel sheets as per the 
mappings that were defined previously. 
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Imported Data: 
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